Installation et démarrage du
Turtlebot &

OpenManipulator-X

Installation Ubuntu Server

Version rapide

e Télécharger I'image compressée de la carte SD préinstallée

https://seafile.unistra.fr/smart-link/dcc9e405-88a0-41d2-ab5c-3e796a6cebf3/
e Insérer la carte SD et démonter les partitions existantes

sudo umount /media/user/writable /media/user/system-boot

Attention, bien vérifier le disque associé a la carte SD avant de lancer la commande dd.

Sinon on risque d'écraser le disque dur. En général disque dur = /dev/sda et carte SD =
/dev/sdb

e Flasher la carte SD avec I'utilitaire dd

sudo gunzip -c ~/turtlebot3-manipulator-humble. img. gz | sudo dd of=/dev/sdb status=progress

e Configurer la connexion automatique au réseau wifi et donner une IP fixe au robot (dans la
plage DHCP autorisée par le routeur) :

o Ejecter et réinsérer la carte SD pour qu'elle se monte
o Modifier la CONFIGURATION RESEAU (les éléments en majuscule) dans le fichier suivant

sudo nano /media/user/writable/etc/netplan/99-hotspot- fablab. yaml

addresses: [IP TURTLEBOT/24]
gateway4: IP BOX


https://seafile.unistra.fr/smart-link/dcc9e405-88a0-41d2-ab5c-3e796a6cebf3/
https://askubuntu.com/questions/1029531/how-to-setup-a-static-ip-on-ubuntu-server-18-04

nameservers:
addresses: [DNS BOX OPERATEUR, 9.9.9.9, 89.234.141. 66]
access-points:
"SSID WIFI":
password: PASSWORD WIFI

Remarque : I'image a été créée apres avoir suivi les instructions longues ci-dessous (et quelques
workspace et package ros installés en plus) en lancant la commande suivante :

sudo dd if=/dev/sda status=progress | gzip -9 > ~/turtlebot3-manipulator-humble. img. gz

Reinitialiser le mot-de-passe

Voir la section 4 ici

Connecter la carte SD sur un PC
e naviguer au point de montage, par exemple :
cd /media/user/writable
e ouvrir le fichier
sudo nano /etc/passwd
e modifier la ligne qui concerne votre user du systeme Ubuntu du turtlebot, par exemple ici

ubuntu

Avant : ubuntu: x: 1000: 1000: Ubuntu: /home/ubuntu: /bin/bash

Apres (on supprime le x ) : ubuntu::1000: 1000: Ubuntu: /home/ubuntu: /bin/bash
e Redémarrer le systéme dans le TurtleBot
e Se connecter avec le login ubuntu
e Aucun MDP n'est demandé

e Lancer le programme de changement de MDP
sudo passwd
e Rentrer le nouveau MDP 2 fois

Version longue

https://emanual.robotis.com/docs/en/platform/turtlebot3/sbc_setup/#sbc-setup
Depuis un ordinateur sous Ubuntu 22.04

e Insérer la carte SD dans le navigateur

Installer rpi-manager sudo apt install rpi-imager
Sélectionner CHOOSE 0S

o autre systeme Linux (Other general-purpose 0S)
o Ubuntu Server 22.04 LTS (64bits)

Sélectionner CHOOSE STORAGE la carte micro SD
Cliquer sur WRITE


https://raspberrytips.com/forgot-raspberry-pi-password/
https://emanual.robotis.com/docs/en/platform/turtlebot3/sbc_setup/#sbc-setup

Depuis une VM WSL Ubuntu 22

Configurer la connexion automatique au réseau wifi et donner une IP fixe au robot (dans la plage
DHCP autorisée par le routeur)

e Ejecter et réinsérer la carte SD pour qu'elle se monte

e Créer le fichier suivant : sudo nano /media/user/writable/etc/netplan/99-hotspot-
fablab. yaml

network:
renderer: networkd
ethernets:
etho:
dhcp4: true
dhcp6: true
optional: true
wifis:
wlano:
dhcp4: false
dhcp6: false
addresses: [192.168.100. 40/24]
gateway4: 192.168.100.1
nameservers:
addresses: [192.168.100.1, 9.9.9.9, 89.234.141. 66]
access-points:
fablab:
password:

version: 2

e Désactiver la configuration du réseau par cloud-init en créant le fichier suivant :
sudo nano /media/user/writable/etc/cloud/cloud. cfg. d/99-disable-network-config. cfg

network: {config: disabled}

Insérer la carte dans le robot, le démarrer assez proche du hotspot wifi configuré, se connecter en
ssh depuis l'ordinateur :

Utiliser I'adresse IP précédemment configurée ssh ubuntu@l92. 168. 100. 40
mdp : ubuntu

changer le mdp par un suffisamment sécurisé

se connecter en ssh avec le nouveau mdp

pour lancer des commandes en root utiliser sudo avec le méme mdp


https://askubuntu.com/questions/1029531/how-to-setup-a-static-ip-on-ubuntu-server-18-04

e Ne pas attendre la connexion réseau pour démarrer :
systemctl mask systemd-networkd-wait-online.service
e Désactiver la veille et I'hibernation :
sudo systemctl mask sleep. target suspend. target hibernate. target hybrid-sleep. target

Installer ROS 2 Humble sans interfaces graphiques (ros-humble-desktop) qui seront lancées sur
I'ordinateur externe :

sudo apt update && sudo apt install locales

sudo locale-gen en US en US. UTF-8

sudo update-locale LC ALL=en US. UTF-8 LANG=en US. UTF-8

export LANG=en US. UTF-8

sudo apt install software-properties-common

sudo add-apt-repository universe

sudo apt update && sudo apt install curl

sudo curl -sSL https: //raw. githubusercontent. com/ros/rosdistro/master/ros. key -o
/usr/share/keyrings/ros-archive-keyring. gpg

echo "deb [arch=$(dpkg --print-architecture) signed-by=/usr/share/keyrings/ros-archive-
keyring. gpg]l http: //packages. ros. org/ros2/ubuntu $(. /etc/os-release && echo $UBUNTU CODENAME)
main" | sudo tee /etc/apt/sources. list.d/ros2. list > /dev/null

sudo apt update && sudo apt upgrade

sudo apt install ros-humble-ros-base ros-dev-tools

source /opt/ros/humble/setup. bash

echo 'source /opt/ros/humble/setup. bash' >> ~/.bashrc

Installer le workspace du turtlebot et les dépendances :

sudo apt install python3-argcomplete python3-colcon-common-extensions libboost-system-dev
build-essential

sudo apt install ros-humble-hls-1fcd-lds-driver

sudo apt install ros-humble- turtlebot3-msgs

sudo apt install ros-humble-dynamixel-sdk

sudo apt install libudev-dev

mkdir -p ~/turtlebot3 ws/src && cd ~/turtlebot3 ws/src

git clone -b humble-devel https: //github. com/ROBOTIS- GIT/turtlebot3. git
git clone -b ros2-devel https: //github. com/ROBOTIS-GIT/1d08 driver.git
cd ~/turtlebot3 ws/src/turtlebot3

rm -r turtlebot3 cartographer turtlebot3 navigation2

cd ~/turtlebot3 ws/

echo 'source /opt/ros/humble/setup. bash' >> ~/.bashrc

source ~/.bashrc


https://docs.ros.org/en/humble/Installation/Ubuntu-Install-Debians.html

colcon build --symlink-install --parallel-workers 1
echo 'source ~/turtlebot3 ws/install/setup. bash' >> ~/.bashrc

source ~/.bashrc

Configurer le Port USB pour OpenCR :

sudo cp "ros2 pkg prefix turtlebot3 bringup /share/turtlebot3 bringup/script/99- turtlebot3-
cdc.rules /etc/udev/rules. d/
sudo udevadm control --reload-rules

sudo udevadm trigger

ID de domain ROS pour la communication DDS :

echo 'export ROS DOMAIN ID=30 #TURTLEBOT3' >> ~/.bashrc

source ~/.bashrc

Configurer le modele du LIDAR :

echo 'export LDS MODEL=LDS-02' >> ~/.bashrc

source ~/.bashrc

Raspberry Pi 5 - Ubuntu Noble 24.04 - ROS2 Jazzy

ROS2 Jazzy est la nouvelle version LTS. Elle est installable sur Raspberry Pi 5.

Pour installer ROS2 Humble sur Ubuntu 24.04 il faut compiler depuis les sources :
sudo apt install -y git colcon python3-rosdep2 vcstool wget python3- flake8-docstrings python3-
pip python3-pytest-cov python3-flake8-blind-except python3-flake8-builtins python3- flake8-
class-newline python3- flake8- comprehensions python3- flake8- deprecated python3-flake8- import-
order python3-flake8-quotes python3-pytest-repeat python3-pytest-rerunfailures python3-
vcstools libx1l-dev libxrandr-dev libasio-dev libtinyxml2-dev
mkdir -p ~/ros2 iron/src
cd ~/ros2 _iron

vcs import --input https: //raw githubusercontent. com/ros2/ros2/iron/ros2.repos src

sudo rm /etc/ros/rosdep/sources. list. d/20-default. list



sudo apt upgrade
sudo rosdep init
rosdep update

rosdep install --from-paths src --ignore-src --rosdistro iron -y --skip-keys "fastcdr rti-

connext-dds-6. 0.1 urdfdom headers python3-vcstool"
colcon build --symlink-install

cf. https://forums.raspberrypi.com/viewtopic.php?t=361746

Montage et Configuration des Dynamixels

https://www.classes.cs.uchicago.edu/archive/2022/fall/20600-1/turtlebot_assembly setup.html

e Installer Arduino IDE : sudo apt install arduino

e https://emanual.robotis.com/docs/en/parts/controller/opencrl10/#install-on-linux

e Connecter OpenCR
https://emanual.robotis.com/docs/en/platform/turtlebot3/manipulation/#arduino-ide

e Installer Dynamixel Wizard

https://emanual.robotis.com/docs/en/software/dynamixel/dynamixel_wizard2/

e Lancer Dynamixel Wizard
cd ~/ROBOTIS/DynamixelWizard2
bash DynamixelWizard2. sh

e Si une erreur de dépendance apparait, désinstaller/réinstaller/upgrader dynamixelWizard
via I'executable ~/ROBOTIS/DynamixelWizard2/maintenancetool

https://emanual.robotis.com/docs/en/software/dynamixel/dynamixel_wizard2/#uninstall-

linux

Pour I'Open-Manipulator

Configurer les dynamixel (baud et ID 11 a 15)
https://www.classes.cs.uchicago.edu/archive/2022/fall/20600-

1/turtlebot_assembly setup.html#arm-first-time :

e Connect a SINGLE motor (no daisy-chains in the arm) to the OpenCR module and
DISCONNECT ALL OTHER MOTORS (the wheel motors!!)


https://forums.raspberrypi.com/viewtopic.php?t=361746
https://www.classes.cs.uchicago.edu/archive/2022/fall/20600-1/turtlebot_assembly_setup.html
https://doc.ubuntu-fr.org/arduino#a_partir_des_depots
https://emanual.robotis.com/docs/en/software/dynamixel/dynamixel_wizard2/
https://emanual.robotis.com/docs/en/software/dynamixel/dynamixel_wizard2/#uninstall-linux
https://emanual.robotis.com/docs/en/software/dynamixel/dynamixel_wizard2/#uninstall-linux
https://www.classes.cs.uchicago.edu/archive/2022/fall/20600-1/turtlebot_assembly_setup.html#arm-first-time
https://www.classes.cs.uchicago.edu/archive/2022/fall/20600-1/turtlebot_assembly_setup.html#arm-first-time

e Open up Dynamixel Wizard 2.0 and update the firmware for that motor by following this

tutorial. The arm Dynamixel model is XM430-W350, and the wheel motors are XM430-
W210.

e Scan for connected Dynamixels using the “Scan” button on the top menu. If the scan does
not turn up any results, you may need to change the scan options in the "Options" menu.
By default, an unconfigured arm motor will have ID 1, be on Protocol 2.0, and have a baud
rate of 57600 bps.

e Change the ID for the detected motor from 1 to 11/12/13/14/15 (whichever you're doing
the procedure for). Click on the “ID” item, and find the ID # you want in the lower right
corner. Click it and press “Save”.

e Change the baud rate to 1M (if not already 1M). Click on the “Baud Rate (Bus)” item, and
find the 1 Mbps option. Click it and press “Save”.

e Disconnect the motor (both in the wizard by clicking “Disconnect” up top and physically
disconnecting from the board) and repeat the steps for the remaining ones

Pour le Turtlebot

Via Arduino IDE ou DynamixelWizard en s'inspirant de :

https://emanual.robotis.com/docs/en/platform/turtlebot3/faq/#setup-dynamixels-for-turtlebot3

e Moteur gauche : ID=1
e Moteur droit : ID=2
e Baud rate : 1M

Test depuis un PC sans la raspberry

Téléopération du OpenManipulator-X seul

Suivre le tutoriel Foxy en remplagant foxy par humble et foxy-devel par ros2 en utilisant
I'interface de communication OpenCR :

https://emanual.robotis.com/docs/en/platform/openmanipulator_x/quick_start_guide/

Pour tester le bon fonctionnement du bras et de sa pince, on connecte la carte OpenCR
directement a un PC ayant ROS Humble préinstallé :

e Installer et compiler le workspace

sudo apt install ros-humble-rqt* ros-humble-joint-state-publisher

mkdir -p ~/openmanipulator ws/src/

cd ~/openmanipulator ws/src/

git clone -b ros2 https: //github. com/ROBOTIS- GIT/DynamixelSDK. git

git clone -b ros2 https: //github. com/ROBOTIS- GIT/dynamixel- workbench. git


https://www.youtube.com/watch?v=FAnVIE_23AA
https://www.youtube.com/watch?v=FAnVIE_23AA
https://emanual.robotis.com/docs/en/platform/turtlebot3/faq/#setup-dynamixels-for-turtlebot3
https://emanual.robotis.com/docs/en/platform/openmanipulator_x/quick_start_guide/

git clone -b ros2 https: //github. com/ROBOTIS-GIT/open manipulator. git

git clone -b ros2 https: //github. com/ROBOTIS- GIT/open_manipulator _msgs. git

git clone -b ros2 https: //github. com/ROBOTIS- GIT/open manipulator dependencies. git
git clone -b ros2 https: //github. com/ROBOTIS-GIT/robotis manipulator. git

cd ~/openmanipulator ws && colcon build --symlink-install

e Corriger le bug de compilation et re-compiler. Dans
src/open_manipulator/open _manipulator x controller/src/open _manipulator x controller. cpp ,
lignes 67-68, remplacer :

this- >declare parameter("sim");
this- >declare parameter("control period")
par :
this- >declare parameter("sim", false);
this->declare parameter("control period", 0.010);
e Lancer arduino
e Uploader I'exemple File > Examples > OpenCR > 10.Etc > usb to dxl vers OpenCR

- Show downloader version

- File and port open information

- Bootloader version

r Result of updating

e Si cela réussit, jump_to fw apparait, sinon essayer d'uploader une seconde fois
e Lancer le contréleur du robot. Attention les moteurs vont bouger et se bloquer

dans la position initiale
ros2 launch open _manipulator x controller open _manipulator x controller. launch. py
usb_port: =/dev/ttyACMO
e Dans un second terminal, lancer le noeud de téléopération :
ros2 run open_manipulator x teleop teleop keyboard

e Piloter le robot dans I'espace Cartésien ou articulaire avec les touches indiquées

Programmation hors-ligne du OpenManipulator-X et
TurtleBot3 depuis Movelt

On suit le tutoriel https://emanual.robotis.com/docs/en/platform/turtlebot3/manipulation/#operate-

the-actual-openmanipulator en installant tout ce qui est censé étre installé sur le raspberry [SBC]/


https://github.com/ROBOTIS-GIT/open_manipulator/issues/240#issuecomment-1632181298
https://innovation.iha.unistra.fr/uploads/images/gallery/2023-07/yhOimage.png
https://emanual.robotis.com/docs/en/platform/turtlebot3/manipulation/#operate-the-actual-openmanipulator
https://emanual.robotis.com/docs/en/platform/turtlebot3/manipulation/#operate-the-actual-openmanipulator

[TurtleBot3] sur le PC [Remote PC].

e Installer le workspace et compiler :

sudo apt install ros-humble-dynamixel-sdk ros-humble-ros2-control ros-humble-ros2-controllers
ros- humble- gripper-controllers ros-humble-moveit

cd ~/turtlebot3 ws/src/

git clone -b humble-devel https: //github. com/ROBOTIS-GIT/turtlebot3 manipulation. git

cd ~/turtlebot3 ws && colcon build --symlink-install

e Ajouter au ~/. bashrc

export ROS DOMAIN ID=30 #TURTLEBOT3

export LDS MODEL=LDS- 02

export TURTLEBOT3 MODEL=waffle pi

export OPENCR PORT=/dev/ttyACMO

export OPENCR _MODEL=turtlebot3 manipulation

e AVANT TOUT FLASHAGE DE OPENCR, se mettre en mode debug en
o Rester appuyé sur le bouton SW2
o Appuyer quelques secondes sur RESET
o Relacher RESET
o Relacher SW2
e ATTENTION SI LE MODE DEBUG n'est pas activé, il se peut jump fw soit affiché mais que le
flashage ait échoué.

e Configurer OpenCR pour turtlebot3 _manipulation depuis Arduino File > Examples >
Turtlebot3 R0S2 > turtlebot3 manipulation oOu avec le prebuild :

rm -rf . /opencr _update. tar. bz2

wget https: //github. com/ROBOTIS- GIT/OpenCR-

Binaries/raw/master /turtlebot3/R0S2/latest/opencr update. tar. bz2
tar - xvf opencr update. tar. bz2

cd . /opencr update

. /update. sh $OPENCR PORT $OPENCR_MODEL. opencr

e Démarrer ROS Control :
ros2 launch turtlebot3 manipulation bringup hardware. launch. py

e Le setup a fonctionné si le robot apparait dans la bonne configuration dans RViz
1

e Dans un second terminal démarrer au choix :
o Movelt pour la programmation hors-ligne et planification de trajectoire :

ros2 launch turtlebot3 manipulation moveit config moveit core. launch. py


https://emanual.robotis.com/docs/en/platform/turtlebot3/manipulation/#operate-the-actual-openmanipulator

o Piloter le robot en bougeant les fleches dans RViz et en cliquant sur "Plan and

Execute"
o Movelt servo

ros2 launch turtlebot3 manipulation moveit config servo. launch. py

o et la téléopération avec le clavier (dans un 3eéme terminal)
ros2 run turtlebot3 manipulation teleop turtlebot3 manipulation teleop

o Piloter le robot dans I'espace Cartésien ou articulaire avec les touches
indiquées

Configuration OpenCR

Pour le Turtlebot : https://emanual.robotis.com/docs/en/platform/turtlebot3/opencr_setup/#opencr-

setup

Pour I'OpenManipulator-X :

https://emanual.robotis.com/docs/en/platform/turtlebot3/manipulation/#opencr-setup

Dépendances manquantes :

sudo apt install ros-humble-hardware-interface
ros-humble-ros2-control ?

ros-humble- joint-state-publisher ?

Dépendances manquantes c6té Raspberry :

sudo apt install rros-humble-gripper-controllers ros-humble- xacro

Dépendances manquantes coté PC :

sudo apt install ros-humble-moveit-servo

Issues :
https://forum.robotis.com/t/ros-2-foxy-openxmanuipaltor-bringup-issues/2142/9
https://github.com/ROBOTIS-GIT/open_manipulator/issues/212
https://github.com/ROBOTIS-GIT/open_manipulator/issues/209

https://www.classes.cs.uchicago.edu/archive/2022/fall/20600-

1/turtlebot_assembly setup.html#arm-first-time


https://emanual.robotis.com/docs/en/platform/turtlebot3/opencr_setup/#opencr-setup
https://emanual.robotis.com/docs/en/platform/turtlebot3/opencr_setup/#opencr-setup
https://emanual.robotis.com/docs/en/platform/turtlebot3/manipulation/#opencr-setup
https://forum.robotis.com/t/ros-2-foxy-openxmanuipaltor-bringup-issues/2142/9
https://github.com/ROBOTIS-GIT/open_manipulator/issues/212
https://github.com/ROBOTIS-GIT/open_manipulator/issues/209
https://www.classes.cs.uchicago.edu/archive/2022/fall/20600-1/turtlebot_assembly_setup.html#arm-first-time
https://www.classes.cs.uchicago.edu/archive/2022/fall/20600-1/turtlebot_assembly_setup.html#arm-first-time
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